Technology Assignment‐Row Operations on TI 83
When you document your steps to solving a problem, you’ll need to use mathematical symbols that are
not available on the keyboard of your computer. Some symbols like powers and subscripts and powers
can be formed by formatting regular text. However many mathematical symbols can only be created
using specialized software designed to work with Word and other word processing software.
In this class, you’ll need to utilize a software package called Mathtype to create matrices. You can
download the software for free via the link in the Orientation folder. If you are working on a campus
computer, the software has already been downloaded and installed. This software is the standard
software used to create documents containing mathematical symbols.
In this technology assignment, you create a system of equations whose solution corresponds to the
number of letters in your name. Once you have created the system you’ll solve the system with the help
of your calculator and then use Mathtype or the equation editor in Word 2007 or 2010 to document
each step. The version of Mathtype that is available of free works best with Word 2003 or 2007. If you
are using Word 2007 you may use Mathtype or the equation editor in Word 2007. If you are using Word
2010, you’ll want to use its built in equation editor.
Your system of equations should have a solution in which the x‐value is equal to the number of letters in
your first name and the y‐value is equal to the number of letters in your last name. For instance, the
solution  x, y    2,1 would correspond to a person whose first name has 2 letters and last name has 1
letter.
There are many systems that could have this solution. For instance, the system

x y 3
2x  3y  1
has the solution  x, y    2,1 . To check, simply substitute x  2 and y  1 into each equation:

2

1 3

2  2   3 1  1
Since both equations are true,  x, y    2,1 is a solution to the system. You’ll need to come up with a
system of equations that corresponds to the number of letters in your name.
Once you have your system, follow the steps below with your system to perform Gauss‐Jordan
elimination on your calculator. Then use the information about Mathtype or the equation editor in
Word 2007 or 2010 to document the steps you followed. On the last page are the final instructions for
this assignment.
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Carry Out the Row Operations on a TI‐84
The description below describes how to carry out row operations to solve the system of equations
above. You can also do these steps on paper without the use of a calculator.
1. To solve the system using row operations, we first need to put
the system of equations into an augmented matrix. For the
system above, the augmented matrix is

 1 1 3
 2 3 1  .


Turn your calculator on and press ‘ to erase anything on
the Home Screen.
3. Press yœ to enter the MATRIX menu. This menu allows you
to refer to a matrix’s name, do math with matrices, or edit a
matrix.
2.

4. We’ll start by entering the matrix into the calculator. Use the ~
button to highlight EDIT. The EDIT menu allows you to enter
matrices of any size into matrices with names [A], [B], ect.
5. Press Í to edit the matrix called [A].
6. The screen shown to the right should look similar to yours. It
indicates that matrix [A] is currently a 2 x 2 matrix (yours may
be different). It also shows the contents of the matrix below the
dimensions.
7. Since the matrix we are entering is a 2 x 3 matrix, change the
dimensions by pressing 2 Í 3 Í. Notice that the matrix
below grows to the proper number of rows and columns as you
enter the dimensions. If you have more than 3 columns in a
matrix, the contents of some of the columns will be off the right
side of the screen and can be accessed using the |, |, }, †
buttons.
8. Enter each of the entries in the augmented matrix followed by
Í. Make sure you have written down this matrix.
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9. Now that we have entered the matrix into the calculator, return
to the home screen by pressing yz.
10. Press yœ to enter the MATRIX menu again.
11. Press ~ to move to the MATH menu in MATRIX.

12. This menu contains all of the commands we’ll use to do row
operations with your calculator. Use the † to scroll down to
the window shown to the right.

13. The first command we’ll use is *row+( . Scroll down to F: *row+(
using the † button and press Í.

14. The syntax for this command is that it requires 4 inputs. First is
a number indicating what we’ll multiply the row by. Second is
the name of the matrix. Third is the row we’ll multiply and last
is the row we’ll add to. In the case of our matrix, we’ll type
*row+(‐2, [A],1,2) indicating that we’ll multiply row 1 in the
matrix [A] by ‐2, and add that to row 2. The result will be placed
in the second row. This should put a 0 in the second row, first
column. To start this command, press ÌÁ¢.
15. Next we need to enter the name of the matrix, [A]. Press
yœ to enter the MATRIX menu.
16. Since NAMES is highlighted and 1: [A], we can press Í to
paste [A] to the *row+( command. If you had stored your
matrix under a different name, you would scroll down to the
appropriate name and press Í.
17. Press ¢.
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18. The next two inputs indicate the row we’ll multiply and which
row we’ll add to. Press À¢Á¤.

19. Press Í to see the result of the row operation. Notice that
the entry in the second row, first column is 0 as desired.

20. We have completed the row operation, but now we need to
save this new matrix as [A]. Press ¿. This will take the
answer we just found, and store it in some location.

21. To specify the location, press yœÍ. This will store the
new matrix in [A].

22. Press Í. Write down this matrix so that you can include it
in the steps you’ll document using Mathtype.
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23. Note that we have a 1 in the first row, first column and a 0 in
the second row, first column. Now we’ll change the ‐5 in the
second row, second column to a 1. To do this we’ll multiply the
second row by ‐1/5 using the *row( command. The syntax for
this is *row(‐1/5,[A],2). The first input is the number you’ll
multiply by. The second input is the name of the matrix. The
last input is the row you’ll multiply. The result will be placed in
the row you’ll multiply. Enter the command so that it appears
like the screen on the right. You’ll need to press yœ~ first
to get to the MATRIX MATH menu.
24. Press Í to carry out the command. Notice that a 1 is now
in the proper place in the matrix.

25. Store the matrix in [A] by pressing ¿yœÍÍ.
Write down this matrix so you can document this step later.

26. In the last row operation, we need to place a 0 in the first row,
second column. We’ll do this by multiplying the second row by ‐
1 and add the result to the first row. Carry out this operation by
reproducing the screen to the right (look at steps 12 through
19).

27. Press Í to carry out the row operation. Notice that a 0 is in
the proper position. Write down this matrix. It indicates that x is
equal to 2 and y is equal to 1. It matches the solution we were
anticipating so we have completed the Gauss‐Jordan process
successfully.
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In some instances you may want to interchange two rows of a matrix. You can do this from the MATRIX
MATH menu using the rowSwap( command. Its syntax is
rowSwap( name of matrix, first row to interchange, second row to interchange)
Typing rowSwap([A],1,2) will interchange the first and second rows in matrix [A].
Always remember to store your matrix using the ¿ button as you work through the process.
Forgetting to do this is the most common mistake students make.

Document Your Steps in Word Using Mathtype in Word 2003 or 2007
Now that we carried out the row operations on a graphing calculator, we’ll document those steps using
Word 2003 or 2007 and Mathtype. You can also use the built in equation editior in Word 2007 or 2010
to carry out these steps. The instructions for using the equation editor in Word 2003 or 2010 are shown
on later pages of this document.
We want to explain the steps like what we see below:
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Step 1: Write down the system of equations.

x y 3
2x  3y  1

Step 2: Write down the corresponding system of equations.

 1 1 3
 2 3 1 


Step 3: Multiply the first row by ‐2, add it to the second row and place the result in the second row or
(‐2 R1 + R2 > R2).

1 1 3 
 0 5 5 


Step 4: Multiply the second row by ‐1/5 and place the result in the second row (‐1/5 R2 > R2).

 1 1 3
0 1 1


Step 5: Multiply the second row by ‐1, add the result to the first row and place the sum in the first row
(‐1R2 + R1 > R1).

1 0 2 
0 1 1 


Step 6: Read the solution from the augmented matrix, x  2 and y  1 .

In the steps below, you’ll learn how to enter a system of equations (as in step 1), an augmented matrix
(as in steps 2 through 5) and an equation on a line (as in step 6) into Word.

Create a System of Equations in Mathtype
1. Start Word 2003 or 2007.
1. Along the top of Word 2007 you’ll see a series of tabs. If Mathtype has been successfully installed,
you’ll see a Mathtype tab. Left click on the Mathtype tab. In Word 2003 you’ll see a menu item
called Mathtype. Click on the tab or menu item.

This panel contains all of the commands to start Mathtype or insert basic symbols. On the right side
is the Insert Equations part of the panel. You can insert an equation within a sentence by left clicking
on Inline. You can insert an equation on a line by itself by left clicking Display. You can even insert
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equations labeled with numbers on the right by left clicking on Right‐numbered.
The Symbols part of the panel allows you to type Greek letters like ,  or mathematical symbols
like , ∞, or .
2. Since we want to create the system of equation on its own line, type some descriptive text (like in
Step 1) and then left click Display.

A Mathtype window like the one above will appear. This is the window we’ll use to create equations,
matrices and other mathematical creations.
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3. Our system of equations is not too complicated and can be created using the buttons on the
keyboard. More complicated expressions we’ll require the use of the buttons you see in the top of
the Mathtype window. Use your keyboard to type in the first equation of your system. The = is
usually in the upper right hand corner of your keyboard.

4. To start your second equation on a new line, press the Enter key on your keyboard.
5. Type the second equation in your system of equations.
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6. This system would look much nicer if the
equations were aligned along the = sign. To
do this, left click on the Format menu along
the top of the window.
7. Select Align at =. Notice that your equations
line up along the = as desired.

8. The system of equations is complete. To
paste this equation into your document, left
click on the File menu along the top of the
window.
9. Select Close and Return to ???? where ????
is the name of your Word document.
10. You should now see the system of equations
on a separate line in your document.
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Create an Augmented Matrix with Mathtype
1. Start Word 2003 or 2007.
2. Along the top of Word 2007 you’ll see a series of tabs. If Mathtype has been successfully installed,
you’ll see a Mathtype tab. Left click on the Mathtype tab. In Word 2003 you’ll see a menu item
called Mathtype. Click on the tab or menu item.
2. Type some descriptive text (like in Step 2) and then left click Display.

3. To start your matrix, create a set of brackets
by selecting
buttons.

from the third row of

4. To create the matrix entries inside of the
brackets, select
from the second
row of buttons.
5. Select the lower right hand sub‐button to
create a variable sized matrix. Other buttons
create matrices with specific sizes.
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6. A box will appear that allows you to enter the number of rows and columns. Enter 2 for rows and 3
for columns as shown below.

7. You can left click between the rows and columns to create solid lines or dashed lines between the
rows or columns. Put a dashed or solid line between the second and third columns. You may have to
click between the columns more than once to get the type of line you want.
8. Enter the values for your augnmented matrix
by clicking your mouse in a space and typing
the number.

9. The augmented matrix is complete. To paste
this equation into your document, left click on
the File menu along the top of the window.
10. Select Close and Return to ???? where ???? is
the name of your Word document.
11. You should now see the augmented matrix on
a separate line in your document.
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Create an Equation within a Sentence with Mathtype
3. Start Word 2003 or 2007.
4. Along the top of Word 2007 you’ll see a series
of tabs. If Mathtype has been successfully
installed, you’ll see a Mathtype tab. Left click
on the Mathtype tab. In Word 2003 you’ll see a
menu item called Mathtype. Click on the tab or
menu item.
5. To insert an equation within a line like in step
6, type some descriptive text. When you get to
the point where you would like to insert your
equation, left click on Inline.
6. Use your keyboard to type the equation, x = 2.

12. When the equation is complete, paste this
equation into your document. Left click on the
File menu along the top of the window.
13. Select Close and Return to ???? where ???? is
the name of your Word document.
14. You should now see the equation within the
sentence in your document.

Using the techniques outlined above, create a Word document and document the steps you used to
solve your system of equations. Use the steps in the box above (steps 1 through 6) as a guide as to how
your document should look.
Once you have documented your steps, save your document and turn it in using the link available
online. Be sure to include your name, class and date in the document.
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Document Your Steps in Word Using the Equation Editor in Word 2007 or 2010
We want to document the steps of solving the system of equations like is shown in the box below.

Step 1: Write down the system of equations.
2

3
1

3

Step 2: Write down the corresponding system of equations.
1
2

1
3

3
1

Step 3: Multiply the first row by ‐2, add it to the second row and place the result in the second row or
(‐2 R1 + R2 > R2).
1 1
3
0
5
5
Step 4: Multiply the second row by ‐1/5 and place the result in the second row (‐1/5 R2 > R2).
1
0

1
1

3
1

Step 5: Multiply the second row by ‐1, add the result to the first row and place the sum in the first row
(‐1R2 + R1 > R1).
1 0 2
0 1 1
Step 6: Read the solution from the augmented matrix,

2 and

1.

In the steps below, you’ll learn how to enter a system of equations (as in step 1), an augmented matrix
(as in steps 2 through 5) and an equation on a line (as in step 6).

Create a System of Equations with the Equation Editor in Word 2007 or 2010
1. Start Word 2007 or 2010.
2. Click on the Insert tab. on the right hand side of
the window is a panel containing the equation
editor button titled Equation. This is the button
we use to create equations, systems of equations,
and matrices. The Symbol button is used to
create individual symbols like  and .
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3. Since we want to create the system of equation
on its own line, type some descriptive text (like in
Step 1) and then press Enter to place the
insertion point on a line in the document.
4. Press the Equation button to begin the system of
equations.
5. Our system of equations can be created using the
Matrix button on the top of the window. To see
this button, make sure you have clicked on the
equation region.
6. Press the Matrix button to reveal a submenu.
7. From the Matrix submenu, locate the button
indicating two rows and one column.

8. Select the button with two rows and one column.
This will insert two spaces in your equation where
you may type the two equations.

9. Select the first row by clicking the mouse in the
space there. Type the equation in that space
using the keyboard.
10. Now click the mouse in the second row and type
the equation for the second equation.
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11. These two equations are not aligned very nicely.
Right click on one of the equations to reveal a
menu.
12. Towards the bottom of the menu is the option for
column alignment. Select this option to reveal
another submenu.
13. Select Right alignment. For this set of equations,
right alignment lines up the equal signs in the
equation. Sometimes it is also necessary to add
spaces to the equations to get the equal signs to
line up.

14. Your system of equation is now complete. You
may click outside of the equation region to
continue editing your non‐equation content in
the Word document.

Create an Augmented Matrix with the Equation Editor in Word 2007 or 2010
1. Start Word 2007 or 2010.
2. Click on the Insert tab. on the right hand side of the window is a panel
containing the equation editor button titled Equation. This is the button
we use to create equations, systems of equations, and matrices.
3. Type some descriptive text (like in Step 2 through 5) and Enter on the
keyboard. Then left click the Equation button.
4. On the left side of the Word window is a bracket button.
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5. When you click on the bracket button, a submenu will appear. Click on the
button shown to the right to insert the brackets in the matrix

6. Click on the space inside the brackets to highlight that area.

7. At the top of the Word window, locate the Matrix button. Select that
button with the mouse.

8. A submenu will appear. Select the matrix containing two rows and three
columns.

9. Click in each of the entries in the matrix and type the entry.
10. Your matrix is now complete. You may click outside of the equation region
to continue editing your non‐equation content in the Word document.

Create an Equation within a Sentence with the Equation Editor in Word 2007 or
2010
1. Start Word 2007 or 2010.
2. Click on the Insert tab. on the right hand side of the window is a
panel containing the equation editor button titled Equation. This
is the button we use to create equations, systems of equations,
and matrices.
3. Type some descriptive text (like in Step 6). When you need to
insert an equation within a sentence, left click the Equation
button.
4. Use your keyboard to type the equation, x = 2.
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5. Click the mouse outside the equation region and continue typing
the sentence.
6. Sometimes Word will place an equation on its own line that you
would like to be within a sentence, To change an equation that is
displayed on its own line to an inline equation, click on the down
arrow in the right corner of the equation region.
7. Select Change to Inline to place the equation within a sentence.
An inline equation can be set on its own line following a similar
procedure, but select Change to Display.

Using the techniques outlined above, create a Word document and document the steps you used to
solve your system of equations. Use the steps in the box above (steps 1 through 6) as a guide as to how
your document should look. Depending on what version of Word you are using, use Word 2003, 2007, or
2010.
Once you have documented your steps, save your document and turn it in using the link available
online. Be sure to include your name, class and date in the document.

